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Thanks for choosing RAINBOW acoustical prediction software as your simulation tool for your PA.

We recommend you read this manual carefully before starting any simulation in order to have a perfect
understanding of how Rainbow works and make the most of it, ensuring a correct and safe use of your sound
equipment.

Our Engineering Department works every day to offer the best solutions to the needs of the market. If
you have any doubt, question or suggestion regarding any of our products, please fell free to contact us.

We appreciate the confidence you have placed in the RAINBOW acoustical prediction software and we
are at your disposal for any collaboration. We are open to any suggestions regarding the use of this software:
As we want to continuously improve our products, your opinion is very important to us.

To find out more about Lynx Pro Audio please contact us or download our latest brochures and/ or
softwares. You can find us at:

www.lynxproaudio.com
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1. - Introduction

Thanks to the RAINBOW software, you will be able to “virtually” determine the acoustical response of
one or various cabinets at the same time. Based on polar response measurements, taken meticulously with a
360º coverage both vertically and horizontally, the Rainbow software is able to calculate the SPL response
including the interaction between them taking into account the magnitude and phase response, in order  to
enable the user to correct cancellations and even to create them if the acoustical design  so requires.

As usual with any Lynx Pro Audio software, Rainbow is very easy to use and offers a very intuitive
design, multi-tool interface and on-line updatable data base. The Rainbow software has been designed by and
for sound technicians. Its aim is to help installers and users of Lynx products. This software is able to import
WMF Vector Files with technical drawings and insert them directly into the prediction window and thus enabling
real measurement predictions. This also helps to determine dead zones and obtain the maximum performance
from each of the cabinets installed.

The RAINBOW software has been completely designed by Lynx Pro Audio S.L. To keep updated with
the latest  version of the software with better and/or new  functions, please do not hesitate to contact us or to
visit  us at www.lynxproaudio.com

1 - INTRODUCTION
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1.1 - Overview

The RAINBOW acoustical prediction software allows among other things:

- Prediction up to 4 LINE ARRAYS of 24 cabinets each simultaneously, together with multiple points
with cabinets

- Flying points information according to the inclination of the cabinets
- Weight calculation of the different systems
- Sub-bass simulation (for instance to achieve cardiod configurations)
- Orientation of cabinets (Horizontal/vertical)
- Throw Direction of cabinets (right/ left)
- Individual delay per cabinet/system
- Polarity selection for each cabinet
- Up to 40 process insertions with Equalization and CrossOver assignable per cabinet.
- Simulation of the Air absorption sound loss with the distance
- SPL Pressure information
- Distance measurement
- Import of CAD files
- Up to 4 audience or hearing zones
- Coverage curves on the hearing zones.
- Export of SPL Map and coverage curves on jpg or bmp format
- Print project report (SPL prediction, flying points, weights, cabinet inclination, polarities, process

aplied, EQ Curves…)

1 - INTRODUCTION
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From here, click on’’Next’’ it will begin the installation process, now follow the instructions on the screen.

2 - INSTALLATION

2.- Installation and first time running

2.1.- Software installation

Before you install your copy of the RAINBOW software, you must verify that your computer meets a
series of minimum requirements to make it work. These requirements are:

- Pentium IV or higher.
- 1024 Mb RAM memory.
- 10 Mb Free Hard disk space.
- Windows™ 2000 / Me / XP / VISTA.

If your computer meets or exceeds these requirements, the software will be installed and operated
without any problem.

It is recommended that you close all applications currently in use. Run the installation file
RAINBOWvX.exe (where X means version supplied). You can also download the latest version at  ww.vmb.es in
the Download area of the website.
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2 - INSTALLATION

Start the installation by selecting the directory where you want to install the program. If you don´t want
it to be installed in the default directory, click with the mouse on the Browse button. Another window appears
where you will be able to chose where to install the program.

Now, give a name to the folder so you will be able to access directly the program from the Start menu.
Once this is done, an information screen appears with all the set-up options you have already defined. Once
everything is confirmed, the actual set-up will start.

At the end of this step, the program will
show the updating history/Record/log with all the
changes that have been introduced since the
last version of the software.

Press Next to continue with the installation
process.
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Once the program setup is completed, the following window appears, confirming that the process is
correct. Press Finish to exit Setup.

2 - INSTALLATION
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2.2.- Uninstall

To uninstall RAINBOW you must follow the same steps common to any software. From the Control
Panel Go to Add / Remove Software. Here select RAINBOW and press the Add / Remove button ...

It is advisable to make a backup of all the configuration files you have created (with .RBW extension) to be able
to use them later on.

The installation program creates an entry in the list of programs from
Windows Start menu under the name RAINBOW.

To operate the program from the Start menu, select Programs, and
search for the Folder named RAINBOW. Then click on the software
icon.

If you created a shortcut to the Windows desktop, just doubleclick
on the icon:

The first thing that appears is the start-up screen which shows the
process of loading the modules of the program, the version and the
name of who has registered the software.
During the program launching process, the software will look for the
latest updates on internet. If some are available it will ask you if you
want to download and install them. You will then have to follow the
instructions described in the point 2.1.

2.3.- Starting RAINBOW

2 - INSTALLATION

When the software first starts, it will ask for some necessary registration
data, so to allocate a user code.

An Internet connection and email address is necessary for
registration so you can receive your validation code.

The process is simple:
1.- Fill in the details and click on "Send registration Data"
2.- Click "Enter Validation Key" and copy the data that will have been
sent to your email address

If you experience errors when sending data, deactivate the anti virus or
firewall.
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3.- Editing with RAINBOW

3.1.- Main Screen

Once Rainbow is operating, the main screen from which you will be able to work with all the
prediction parameters, is displayed. Here it is:

From the Main menu you are able to access options of project reading, creating and saving as well as
view options, insertion of cabinets and configuration options.

- File Menu: from here you can create a new project, save it and export the SPL drawing by “jpg” or
“bmp” and print a configuration report of it. You will also be able to exit the application.

- Edit Menu: it allows you copy, paste and import a CAD drawing file on WMF format (with transparent
background) to overlapping the calculated prediction.

- View Menu: you can customize visual options allowing to show or to hide:
- Four Audience Zones
- Import Venue CAD drawing.
- Throw Lines
- Grid Lines
- SPL Mapping
- Box angles and identification of cabinets
- etc…

- Options Menu: it allows you to configure your software: language, project information, visual options,
metric units, environment data, etc…

- Help Menu: it shows you which set up version you have.

3 - EDITING WITH RAINBOW

Working
Sections

Render
Parameters

Listening Areas

Prediction
window

SPL Colour range
Main Screen

Audience Zone
configuration

Capture and
compare
predictions
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3 - EDITING WITH RAINBOW

From this section you can configure everything referring to the listening zones. According to the orientation
of the listening zone you will be able to see it as a horizontal or vertical view, the latter being setup as default.

3.2.- Venue Data

The listening area design is set up by introducing the beginning and ending positions of each of the four
available zones.

For a zone to be activated, just select it with the Zone Selector, you will then see the corresponding
zone in the prediction window. There are some keyboard shortcuts to activate and deactivate zone displays
(press CTRL + 1 for zone 1 ; CTRL + 2 for zone 2 ;CTRL + 3 for zone 3 y CTRL + 4 for zone 4).

In order to draw the Listening zones, write the X and Y co-ordinates of the beginning and the end of the
zone. X co-ordinate fix the length of the listening area (LENGTH). If Zone orientation is VERTICAL, the coordinate
Y will fix the height of the listening zone but if it’s HORIZONTAL Y will fix the width of the hearing zone. To
modify the HORIZONTAL data you have to select it previously in the orientation.

For the vertical view you can also select between sitting or standing audience, each zone being adjustable
independently.

Zones Orientation

Import venue drawingsZone
Selection

Vertical Zone Audience Horizontal Zone
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Finally you can import a WMF file with a CAD drawing of the place to sonorize. This drawing must have
a transparent background otherwise it won´t match correctly in the prediction window and you won´t be able to
see the SPL Map.

A dialog box will be displayed from which you will be able to preview the drawing to import.

After the Metafile is open, the software will ask you to introduce the length and height in meters/feet (according
to the global units configuration) of the drawing to import for it to fit perfectly in the prediction window.

                       How to export an AutoCAD WMF with a transparent background?

For AutoCAD 2000 or higher, you have to use the system variable WMFBKGND and put it in “OFF”
to obtain a transparent background. This is the default value in general.

Then go to Menu -> File -> Export WMF

3 - EDITING WITH RAINBOW
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3 - EDITING WITH RAINBOW

3.3.- Line Array Configuration

From this working section you can set up the different Arrays to be positioned.

Flying point detailsBox Angle

Array
Configuration

Array Selection Array  Mute
Section

The first thing we have to do is to select the Model you are going to setup for the array from the
Box Model option inside the Line Array configuration section.
Once you have selected a model you can decide how many cabinets are going to be flown (you can
select up to 24 units). Now you can modify the angle of each box as well as the general angle of the array.
You can also select the direction of the cabinets, left or right, and their vertical or horizontal orientation.
To position the Array on the prediction window you will use the X and Y values.

As you add and modify the box angles, you will automatically be shown the center of gravity of the
array as well as the point from where it has to be flown. This information will be shown on the detailed
picture (Flying Frame) together with the weight of the array. This last information is very important when
you have to fly the equipment on a structure with a limited loading capacity.

Once your array is set up, and if necessary, you can apply an independent Digital Process into
each box. You can equalize, change the gain, invert its polarity or add delay. It is very practical when you
want to simulate delay lines for instance.

You can have up to 4 independent array systems on the same prediction window, and simulate the
interaction between them and with other cabinets also placed in this prediction window.

There is also a global Mute option to study what is the effect of that array on the whole system as well as
a button to delete it completely

Delete Array

DSP Process
Inserted
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3 - EDITING WITH RAINBOW

3.4.- Cabinets

From this working section you can easily add any cabinet from the Lynx range (installation series, sub-
bass, self-powered…). Line Array cabinets will be positioned in the Line Array Configuration section.

To insert a new cabinet, just go to the Insert menu and select the cabinet you want to add. Another
method is to click with the right button of the mouse on the list of cabinets and quickly select the cabinet you
want to insert.

The model of cabinet can be easily changed at any time: just click on the name and a list of all the available
cabinets will appear.

From here you can also modify the position of the cabinet as well as its angle of inclination, its vertical or
horizontal orientation, and throw direction, Left or Right.

You will also be able to apply an independent signal Process Insertion for each cabinet and modify its equalization,
gain, polarity and delay.

You can also switch off the cabinets (MUTE column) to simulate its influence on the coverage areas.

To delete cabinets from your project, just place the mouse on the identification number of the cabinet and click.
You will have the option to delete it.
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3.5.- Prediction window

This section shows you all the elements you have inserted in your project: distribution of cabinets, array
coverage angles, throw direction, listening areas, etc…

Zoom Selection SPL colour range

Thanks to the plus and minus signs of the magnifying glass symbol, you can Zoom In or Zoom out the
image for a better detail of the area. Also we have an arrow type control to move the image up and down and
from right to left. You can also input the distance of the Prediction Window you want to simulate.

With the colour range of the SPL pressure, you can tell the software which pressure range we want to
show in our representation of colours. There is a default 35 dB SPL range. It is also possible to fix the
maximum SPL pressure level so as to compare with other predictions. By default it is configured as Normalized
(max. automatic level).

You can see the cabinets you placed and their coverage and the setup angles. The grid can be adjusted
through setup options as well as the elements you want to show from the View menu.

Once the cabinets are placed in the project, you can tell the program to show you the prediction for a
frequency you decide through the RENDER control.

This control allows selecting the quality of the RENDER through the RENDER
RESOLUTION Slider. For a better quality slide it on the left but the prediction will
take longer.

The SMOOTH control is used to tell the software to soften cancellations to show
a more uniform prediction.

From the FREQUENCY control you can select the frequency of the prediction.

Once the quality of render is established, click on the SPL MAP button to see the
prediction of your sound project.

3 - EDITING WITH RAINBOW

Capture and com-
pare SPL prediction

Length of the
prediction area
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As you can see in this picture, we have inserted an array with a listening area. We have inserted a
drawing of a theatre and we have simulated the vertical coverage at a 1000 Hz frequency with high resolution
and medium smooth.

The maximum pressure you can have is indicated by the representative SPL range that shows 137 dB
for the dark red colour. You can know the SPL pressure at any point of the image by placing the mouse on the
prediction image and click with the right button on it. A tool bar will be displayed with the following options:

Indicating the SPL pressure at that point
Zoom Selection
Ruler for measuring distances, angles and delay
Moving elements
Indicating X and Y position at that point

3 - EDITING WITH RAINBOW
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3 - EDITING WITH RAINBOW

3.6.- Coverage

From the COVERAGE section you can graphically and precisely view the coverage, both vertically and
horizontally and see the corresponding pressure levels.

When you have vertical zone orientation in the VENUE section, the coverage curve will appear with the
colour of each zone. This way, you can simultaneously view all active sound zones. The curve is displayed with
the same SPL range as selected from the colour palette for the vertical axis and with the same distance as the
prediction window.

Each coverage representation is linked to its listening zone, so that if you ZOOM or move away you can
still follow it.
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3 - EDITING WITH RAINBOW

If you select horizontal orientation in VENUE section the format will be similar to the vertical representation.
The main difference will be that now you can move the listening line within the zone and see how the coverage
differs.

To move the listening line from each zone select MOVE from the toolbar (this can be viewed by right
clicking in the prediction window).

Once selected, you can move the representation line by clicking on the thicker coloured line from each
zone independently.

The coverage curves can be exported as jpg or bmp from the menu file.
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3.7.- Process Insertions

3 - EDITING WITH RAINBOW

From this section, we will configure all the processes we need to apply to each cabinet or group of
cabinets.

It will start with the 16 process insertions, which
can be increased to a maximum of 40.
From  Menu->Insert -> New Process , we can add new
process channels.

In each process channel the following is available:

-  9 equalization filters  with various options (see right).
- High pass and low pass CrossOver up to 48dB/Oct, with
 Linkwitz Riley, Butterwoth, Bessel options.
- Gain control.
- Polarity inversion.
- Delay.

Also,  each process can be set  with a name so that it can be quickly identified in the project.




